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Value Trades Excel Add-Ins Installation Guide for macOS

Step 1: Download the Manifest File

e Download the provided manifest.xml file from your vendor or internal source.
e Save it to a known location such as your Downloads folder.
e This file contains the necessary configuration for Excel to load the Value Trades Add-In

Step 2: Open Excel

e |aunch Microsoft Excel on your Windows system.
e Clickthe File menu located at the top-left corner of the window.
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Step 3: Open Excel Options

e |nthe File menu, click on Options at the bottom of the list.
e This opens the Excel Options configuration window.
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Step 3: Enable the Developer Tab

e In the Excel Options window, click Customize Ribbon.
e On the right side, check the box labeled Developer.
e Click OK to save the changes. The Developer tab will now appear in Excel’s main menu bar.
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Step 4: Create a Shared Folder for the Manifest File

e Create a new folder on your system named Shared (or any name of your choice).
e Place the manifest.xml file inside this folder.

e Right-click the folder and select Properties.

e Go to the Sharing tab and click Advanced Sharing.

e Check Share this folder, then click Apply and OK.

e Note the shared folder network path—this will be required in the next steps.
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Step 5: Configure the Trusted Add-in Catalog

e Go back to Excel and click the File menu again.

e Click Options.

e In the Excel Options window, select Trust Center.

e Click Trust Center Settings to open a new window.

e Choose Trusted Add-in Catalogs from the left panel.

e Inthe Catalog URL field, enter the shared folder path you noted earlier.
e C(lick Add catalog. It will appear as a new row in the list.

e Check the box labeled Show in Menu, then click OK.

e Close all open dialogs by clicking OK.
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Step 6: Load the Add-In from Shared Folder

e C(Click the Developer tab in Excel’s main ribbon.

o= [£] Properties B @ Import
OB B el Bl E : .
Add-  Excf 2
ins  Add- X
Add- ~
Trusted Publishers Trusted Web Add-in Catalogs
Trusted Locations )
Tristed Docoments Use these settings to manage your web add-in catalogs.
["] Don't allow any web add-ins to start.
E | Trusted Add-in Catalogs [ Don't allow web add-ins from the Office Store to start. (= % w a
Add-ins [} Next time Office starts, clear all previously-started web add-ins cache.
AkuveX Fettings Trusted Catalogs Table
Macro Settings
) You should only add a catalog if you trust its owner. You may also select one of each catalog type to show in the
Protected View insert add-in menu. We will automatically start web add-ins from your insert add-in menu catalogs when opening
Message Bar gocimens,
Catalog Url: | | Add catalog |
External Content
. y Tr Manage Add-in Catalogs X |Show in Menu
File Block Settings
Privacy Options 0 We've saved your settings, they'll be applied next time you start Office.
Form-based Sign-in —_——
P[]
[}
Remove |
Clear |
—————————
1
9 H ok || émel
T e == EW T ,ﬁ‘— i T
v
K »
B & 100%
Formulas Data Review View Developer Help
o= [£] Properties @ B @ Import
SR A= 1N
Add-  EXcq Excel Options ? X
ins  Add-
Adgy (BG ; ' Help keep your documents safe and your computer secure and healthy. K
Formulas ~
Data Security & more
2 || Proofing Visit Office.com to learn more about protecting your privacy and security. ¥ 7 o 7
| G Microsoft Trust Center | ]
Language
Microsoft Excel Trust Center
Accessibility
The Trust Center contains security and privacy settings. These settings help keep your
Advanced computer secure. We recommend that you do not change these settings. Trust Center Settings...
Customize Ribbon
Quick Access Toolbar
Add-ins
Trust Center
&
e - -
: | ok || Mcancel |
i T i
v
i e »
B & 100%

12|Page



e Click Add-ins.

e |n the Office Add-ins popup, click the SHARED FOLDER link.

e Click the Refresh link in the top-right corner.
o After refreshing, the Value Trades icon should appear.
e If it does not appear, close Excel and reopen it.
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Step 7: Access the Value Trades Add-In

e Once the add-in appears, click its icon to load it.

e A new Value Trades menu will appear in the Excel ribbon.
e C(lick the Value Trades menu and then the Value Trades icon.
e The add-in panel will open on the right side of Excel.
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Step 8: Enter and Validate Your API Key

e In the right-side panel, locate the APl Key input field.

e Type or paste your provided API key.

e C(lick the Save button. The system will validate the key and display a confirmation message.
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Sheet! | (3

Ready E® T Accessibilty: Good to go

B 9 ¢ = sook - Excel O Ssearch

Fle Home Insert Pagelayout Formulas Data Review View Developer Help Value Trades

L 5 B @ b G O

value | Create  Overview Valuation  Financials Dividends = Financial Refresh Refresh
Trades | Sample ~ - - B Highlights ¥ Price  All

Task pane 'sample Data  Overview and valuation  Financial and Dividend  Finandial Highlights  Refresh Excel Data

Al ~ i S

Sheetl | @)

neacy B T Accesiviny: Good 1o 9o

o
I
Q
X

[

Value Trades voXx

o

VALUE TRADES

Value Trades Excel Tool

Please Enter a Valid API KEY!

Value Trades Functions

Enter Cell Value of Symbol

Name v

Insert Formula

v © 2025 value-trades.com. Al rights reserved

>
&) add-ins loaded successfully B H -+ s

=]
X

Share ~

[F3

Value Trades v

o

VALUE TRADES

Enter your API Key

Value Trades Functions

Enter Cell Value of Symbol

Name hd

Insert Formula

v © 2025 value-trades.com. All rights reserved

»
adeins osceasuceessy B B -

Step 9: Generate a Sample and Explore Menu Options

e C(lick Create Sample to generate a sample data sheet.
e This will populate a list of symbols and values for verification.

e Explore other menu options as needed to fully utilize the Value Trades Excel Tool.
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File

Book1 - Excel

Home Insert Page Layout Formulas

= 3 g )

o5 C- | Bad -
Value Create Overview Valuation Financials Dividends Financial Refresh Refresh
Trades | Sample - - - Highlights ~ Price Al

Data

Review  View

Developer

P search

Help  Value Trades

Task Pane 'Sample Data  Overview and Valuation  Financial and Dividend  Financial Highlights  Refresh Excel Data ~

Al v i S Symbel ~
A B € D E F G H ] K L M N o P Q R
ElSymbol |Name  Current Pr Current Pr Current Pr 52-Week L Fair Value| Value Trades v X
2 MSFT
3 AAPL
4 NVDA '
5 GOOGL ’\I,
6 AMZN VALUE TRADES
7 META
8 BRK-A Value Trades Excel Tool
9 TSM
10 LY API Key saved successfully!
11 AVGO
12 TSLA
13 JPM
:; LMT Enter your APl Key
16 XOM
17 UNH
18 NVO Value Trades Functions
19 MA
20 PG
N Enter Cell Value of Symbol
2
23 Name ¥
24
:
26
27
28
29
30
31 v © 2025 value-trades.com. All rights reserved.
Sheet1 @ ] N

Ready Caluate [@ % Accessibility: Good to go &2 Value Trades is working on your Create Sample H & ———+ 0%
@ H9 ¢ c Bookl - Exel £ search ® - o «x

File ~Home Insert Pagelayout Formulas Data Review View Developer Help Value Trades Table Design

Table Name: [ summarize with PivotTable E!? @ ™ B ] Header Rew [ First Column Filter Button e [r————

StockDataTable [? [ Remove Duplicates Insert mz Befiash B O TotalRow [ Last Column 5 e——

& ResizeToble (3 Convert o Range sheer | v v gl %] Banded Rows [ Banded Columns e S

Properties Tools External Table Data Table Style Options. Table Styles ha]
5 Teble Nome Symbol ,\
Edit the name of this table used to
refer to it in formulas.
H 1 K L M
1 < Change [l Current Value Trades v
2 MSFT Microsoft Rs523.61 Rs3.05 58.59% Rs343.59  Rs393.44.
3 AAPL Apple Inc Rs262.82 Rs0.00 0.00% Rs168.80  Rs199.84.
4 NVDA  NVIDIACC Rs186.26 Rs4.10 225.08% RsB6.61  Rsl61.17) .'I
5 GOOGL Alphabet! Rs259.92 Rs6.84 270.27% Rs140.23  Rs219.31 M
6 AMZN  Amazon.c Rs224.21 Rs0.00 0.00% Rs161.38  Rs133.52 VALUE TRADES
7 META Meta Plati Rs738.36 Rs4.36 59.40% RsA79.43  Rs593.11
8 BRKA  Berkshire Rs738,500.00 Rs0.00 0.00%  Rs657,497.50 #heskbess Value Trades Excel Tool
9 TSM Taiwan Se Rs294.96 Rs4.23 145.50% Rs133.34  Rs234.54
10 LY Eli Lillyam: Rs826.45 Rs.41 53.71% Rs622.41  Rs423.92 Sample data inserted and formatted successfully!
11 AVGO  Broadcon Rs354.13 Rs0.00 0.00% Rs137.54  Rs146.17
12 TSLA Teslalnc Rs433.72 Rs0.00 0.009% Rs214.25  Rs40.13’
13 JPM JPMoigan Rs300.44 Rs5.90 200.31% Rs200.22 Rs273.10
14V Visa Inc. € Rs347.38 Rs1.42 41.05% Rs271.33  Rs312.47
15 WMT  Walmant] Rs106.17  Rs0.00 0.00% Rs79.43  Rs41.33 Entenyour ATYRSYy
16 XOM Exon Mot Rs115.39 Rs0.59 50.87% Rs86.01  Rs99.59)
17 UNH UnitedHe: Rs362.50 Rs2.05 56.879% Rs234.60 Rs263.46
18 NVO Novo Nore Rs52.96 Rs0.27 50.72% Rsd4.55 Rs487.45 Value Trades Functions
19 MA Masterca Rs573.67 Rs0.10 1.74% Rs464.22 Rs470.17
20 PG Procter & Rs152.49 Rs1.33 87.83% Rs148.91 Rs128.88
21 N Johnson & Rs190.40 Rs2.07 107.55% Rs137.37  Rs190.43 EntenCell Velueof Symbol
si Name ¥
24
:
26
27
28
29
30
3 v © 2025 value-trades.com. All rights reserved.
Sheet1 @ ] >
Ready T2, Accessibility: Good to go &2 we're starting the add-ins runtime. just a moment... H & ———+ 00%
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File Home Insert

Booki - Excel

£ Search

Page layout Formulas Data Review View Deweloper Help Value Trades Table Design

o B g i3 @4 B Q0
== | lo=] = | Ada b )

Value = Create  (Overview|Valuation Financials Dividends Financial Refresh Refresh

Trades = Sample ~ - - v Highlights ~ Price Al

Task pane |sample Data [~ fy oo jidend  Finandial Highlights  Refresh Excel Data

AL ] f Descriptin

@ official Site
A B | fo sector F G H
1 - fu Incustry Change [l Current 52-Week Low [ FairValue [
2 MSFT Microse Rs3.05 Rs343.59  Rs393.44.
3 AAPL AppleIn fi Price Rs0.00 Rs168.80  Rs199.84]
4 NVDA  NVIDIA iy price change Rs4.10 Rs86.61  Rs161.17)
5 GOOGL Alphabe Rs6.84 Rs140.23  Rs219.31
6 AMZN  Amagoq f® Price Change Percentage Rs0.00 Rs161.38  Rs133.52
7 META MetaPl  fu preyious Close Rs4.36 Rsd79.43  Rs533.11
8 BRKA  Berkshi Rs0.00 Rs657,497.50 #asabsyass
9 TSM Taiwan{ f 52WeekLow Rs4.23 Rs133.34  Rs234.54
10 LY EliLily2 fin 55 week High Rs4.41 Rs622.41 Rs423.92
11 AVGD  Broade{ _ Rs0.00 Rs137.54  Rs146.17,
12 TSLA Teslaln| fi9 Latest Share Count | Rs0.00 Rs214.25  Rsd0.13’
13 JPM IPMOIB! fia Sare Count 5 Vears Ago Rs5.90 Rs200.22  Rs273.10
14V Visa Inc Rs1.42 Rs271.33 Rs312.47
15 WMT Walmart| Rs108.17 Rs0.00 Rs79.43 Rs41.33.
16 XOM Exxon Mol Rs115.39 Rs0.59 Rs96.01 Rs99.59
17 UNH UnitedHe: Rs362.50 Rs2.05 Rs234.60  Rs263.46.
18 NVO Nowo Nore Rs52.96 Rs0.27 50.729% Rsd4.55 Rs487.45
19 MA Masterca Rs573.67 Rs0.10 1.749% Rs464.22  Rsd70.17.
20 PG Procter & Rs152.49 Rs1.33 87.83% Rs149.91 Rs128.86
21 N Johnson & Rs190.40 Rs2.07 107.55% Rs137.37  Rs190.43;
2
23
24
25
26
27
28
29
30
31
Sheet1 @ i 4

Ready T, Accessibility: Good 1o go

d@ B2 T < Book - Exel £ search

File Home Insert

Trades = Sample

Page layout Formulas Data Review View Deweloper Help Value Trades Table Design

B e &

Value = Create  Overview [Valuation| Financials Dividends

Hi

Financial Refresh Reiresh

ighlights >~ Price Al

ighlights  Refresh Excel pata

3

&2 we're starting the add-ins runtime, just a moment..

Task pane | sample Data overvew a4y Foic oo
Al - S s pe ratio
#9 PEG Ratio
T\ B # Forward PE Ratio F @ H

L ## Price To Book Ratio 52-Week Low K Fair Value K3
2 MSFT Microseft g Rs343.59  Rs393.44
3 AAPL Apple Inc ¥ Price To Sell Ratio Rs168.80 Rs199.84
4 NVDA  NVIDIACC i Euto Ebitda Rs86.61  Rs161.17)
5 GOOGL  Alphabet| Rs140.23 Rs219.31
6 AMZN  Amazon.c # Market Capatilzation 0.00% Rs161.38  Rs133.52
7 META Meta Plati fin Revenue Converted To Cash Flow 59.40% Rsd79.43 Rs593.11
8 BRK-A  Berkshire Rs7{ 0.003%  Rs657,497.50 #ikaisysss
9 TSM Taiwan Se 0 Average ROE 145.50% Rs133.34  Rs234.54
10 LLY EliLillyam: SAAT 53.71% Rs622.41  Rs423.92
11 AVGO  Broadcon Rs354.13 Rs0.00 0.00% Rs137.54  Rs146.17)
12 TSLA TeslaInc Rs433.72 Rs0.00 0.00% Rs214.25 Rs40.13
13 JPM JPMoigan Rs300.44 Rs5.90 200.31% Rs200.22 Rs273.10
14V Visa Inc. € Rs347.38 Rs1.42 41.05% Rs271.33 Rs312.47
15 WMT Walmart| Rs106.17 Rs0.00 0.00% Rs79.43 Rs41.33
16 XOM Exxon Mol Rs115.39 Rs0.59 50.87% Rs96.01 Rs99.59
17 UNH UnitedHe: Rs362.50 Rs2.05 56.87% Rs234.60 Rs263.46
18 NVO Nowo Nore Rs52.96 Rs0.27 50.729% Rsd4.55 Rs487.45
19 MA Masterca Rs573.67 Rs0.10 1.74% Rs464.22 Rs470.17
20 PG Procter & Rs152.49 Rs1.33 87.83% Rs149.91 Rs128.86
21 INJ Johnson & Rs190.40 Rs2.07 107.55% Rs137.37  Rs190.43,
22

23

24

25

26

27

28

29

30

3

Sheet1 @ P4

Ready T, Accessibility: Good 1o go

3

&2 we're starting the add-ins runtime, just a moment..

Value Trades voXx

Value Trades Excel Tool
Sample data inserted and formatted successfully!

Save

Enter your APl Key

Value Trades Functions

Enter Cell Value of Symbol

Name v

© 2025 value-trades.com. Al rights reserved
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Value Trades voXx

o

VALUE TRADES

Value Trades Excel Tool
Sample data inserted and formatted successfully!

Save

Enter your API Key

Value Trades Functions

Enter Cell Value of Symbol

Name v

© 2025 value-trades.com. Al rights reserved
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File Home Insert Pagelayout Formulas Data Review View Developer Help Value Trades Table Design

Value Trades voXx

Value Trades Excel Tool
Sample data inserted and formatted successfully!

Enter your API Key

Value Trades Functions

Enter Cell Value of Symbol

Name v

v © 2025 value-trades.com. Al rights reserved

- . g
& B i 2 & (D)

Value = Create  Overview Valuation [Financials|Dividends Financial Refresh Refresh

Trades = Sample ~ - T v Highlights ~ Price  All

Task Pane | Sample Data  Gverview and valuation fi9 Book Value resh Excel Data

Al i Jv| symbol | gy gps

F@ Previous EPS
F0 Next eps F @ H
1 for average EPS 2-Week Low [ FairValue [
2 MSFT Microseft A 58.59% Rs343.59  Rs393.44.
3 AAPL Apple Inc F Diluted 95 TIM 0.00% Rs168.80  Rs199.84]
4 NVDA  NVIDIACC f cash 225.08% Rs86.61  Rs161.17)
5 GOOGL  Alphabet! . 270.279% Rs140.23  Rs219.31
6 AMIN Amazon.c 71 Debt 0.00% Rs161.38  Rs133.52
7 META Meta Plati fm Net Debt 59.40% Rsd79.43  Rs533.11
8 BRKA  Berkshire Rs738,500.00 | * 0.003%  Rs657,497.50 #isisysss
9 TSM Taiwan Se #0 Ebitda 145.50% Rs133.34  Rs234.54
10 LY EliLillyan: fot Free Cash Flow 53.71% Rs622.41  Rs423.92
11 AVGO  Broadcon ) 0.00% Rs137.54  Rs146.17)
12 TSLA Testalnc fi Average Free Cash Flow Growth | 0,0096 Rs214.25 Rs40.13
13 JPM JPMorgan o Latest Revemue 200.31% Rs200.22  Rs273.10
14V Visa Inc. € . 41.05% Rs271.33 Rs312.47
15 WMT Walmart| #9 Average Revenue 0.00% Rs79.43 Rs41.33]
16 XOM  ExxonMol o0 Lasts Vears Avg i 50.87% Rs96.01  Rs99.59
17 UNH UnitedHe: 56.87% Rs234.60  Rs263.46.
18 NVO Nowo Nore fi Revenue Four Years Ago 50.72% Rsd4.55 Rs487.45
19 MA Masterca T R0 174% Rs464.22  Rsd70.17.
20 PG Procter & Rs1.33 87.83% Rs149.91 Rs128.86
21 INJ Johnson & Rs190.40 Rs2.07 107.56% Rs137.37  Rs190.43,
22
23
24
25
26
27
28
29
30
31
Sheet1 @ P4

ready [E® % Accessibility: Good 1o go

3 B9 ¢ = Bookl - Excel £ Ssearch

File  Home Insert Pagelayout Formulas Data Review View Developer Help Value Trades Table Design

4 B3 i B D

Q@

Value ~ Create  Overview Valuation Financials [Dividends| Financial Refresh Refresh

Trades ~ Sample v v v v

Task Pane | Sample Data _ Overview and valvation _Financiaarf

A1 v i fx Symbol fn

Highlights v Price  All

resh Bxcel Data

Dividend Per Share

Dividend Yield
#® Dividend Payout Ratio
f Dividend Payout Date F G H
1 me [l Current Price B Current Pri # Ex-Dividend Date
2 MSFT Microsoft Rs523.61 S 58.59% Rs343.59 Rs393.44
3 AAPL Apple Inc Rs262.82 Rs0.00 0.00% Rs168.80 Rs199.84
4 NVDA NVIDIA Cc Rs186.26 Rsd.10 225.08% Rs86.61 Rs161.17
5 GOOGL  Alphabetl Rs259.92 Rs6.84 270.27% Rs140.23 Rs219.31
6 AMZIN Amazon.c Rs224.21 Rs0.00 0.00% Rs161.38 Rs133.52
7 META Meta Plati Rs738.36 Rs4.36 59.40% Rs479.43 Rs593.11
8 BRK-A Berkshire  Rs738,500.00 Rs0.00 0.00%  Rs657,497.50 #E###k#iEE
9 TSM Taiwan Se Rs294.96 Rs4.23 145.50% Rs133.34 Rs234.54
10 LLY Eli Lily ane Rs825.45 Rs4.41 53.71% Rs622.41 Rs423.92
11 AVGO Broadcon Rs354.13 Rs0.00 0.00% Rs137.54 Rs146.17
12 TSLA Teslalnc Rs433.72 Rs0.00 0.00% ‘Rs214.25 Rs40.13
13 JPM JPMorgan Rs300.44 Rs5.90 200.31% Rs200.22 Rs273.10
Uy Visalnc. ¢ Rs347.38 Rs1.42 41.05% Rs271.33  Rs312.47
15 WMt Walmart| Rs106.17 Rs0.00 0.00% Rs79.43 Rs41.33
16 XOM Exxon Mot Rs115.39 Rs0.59 50.87% Rs96.01 Rs99.59
17 UNH UnitedHe: Rs362.50 Rs2.05 56.87% Rs234.60 Rs263.46
18 NVO Novo Nore Rs52.96 Rs0.27 50.72% Rs44.55 Rs487.45
19 MA Masterca Rs573.67 Rs0.10 1.74% Rs464.22 Rs470.17
20 PG Procter & Rs152.49 Rs1.33 87.83% Rs149.91 Rs128.86
21 IN) Johnson & Rs190.40 Rs2.07 107.55% Rs137.37 Rs190.43;
22
23
24
25
26
27
28
29
30
31
Sheet1 ©) HR )

Ready %, Accessibility: Good 10 go

3
&) we're starting the add-ins runtime, just a moment.. B H e

® - o «x

Value Trades M X

VALUE TRADES

Value Trades Excel Tool
Sample data inserted and formatted successfully!

Enter your API Key

Value Trades Functions

Enter Cell Value of Symbol

Name Y

Insert Formula

v © 2025 value-trades.com. All rights reserved.
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File Home Insert Pagelayout Formulas Data Review View Developer Help Value Trades Table Design

s D 4B &b (B A0
= o= L] bad o
Value | Create  Ovenview Valuation Financials Dividends | Financial | Refresh [gfresh

Trades  Sample v Highlights | Price ~ All

| S
Task Pane | Sample Data_ Overview and Valuation _Financial and Dividend  Fif ) £ ning Date
|

AL v i S| Symbol f@ 50 Days Moving Avg
f# 200 Days Moving Avg
A B (3 D E F G H
il Symbot B Name B Current Price Bl Current Price Change [l Current Price Change Week Low [B Fair Valu
2 MSFT Microsoft Rs523.61 Rs3.05 58.59% Rs343.59  Rs393.44
3 AAPL Apple Inc Rs262.82 Rs0.00 0.00% Rs168.80  Rs199.84
4 NVDA  NVIDIACC Rs186.26 Rs4.10 225.08% Rs86.61  Rs161.17
5 GOOGL Alphabet! Rs259.92 Rs6.84 270.27% Rs140.23  Rs219.31
6 AMZN  Amazon.c Rs224.21 Rs0.00 0.00% Rs161.38  Rs133.52
7 META Meta Plati Rs738.36 Rs4.36 59.40% Rs479.43  Rs593.11
8 BRK-A  Berkshire Rs738,500.00 Rs0.00 0.00%  Rs657,497.50 s#ssbtass
9 TSM Taiwan Se Rs294.96 Rs.23 145.50% Rs133.34  Rs234.54
10 LLY EliLillyan: Rs825.45 Rs4.41 53.71% Rs622.41  Rs423.92
11 AVGO  Broadcon Rs354.13 Rs0.00 0.00% Rs137.54  Rs146.17
12 TSLA Teslalnc Rs433.72. Rs0.00 _0.00% Rs214.25  Rs40.13
13 JPM JPMorgan Rs300.44 Rs5.90 200.31% Rs200.22  Rs273.10
UV Visalne. € Rs347.38 Rs1.42 41.05% Rs271.33  Rs312.47
15 WMT ‘Walmart! Rs106.17 Rs0.00 0.00% Rs79.43  Rs41.33
16 XOM Exxon Mot Rs115.39 Rs0.59 50.87% Rs96.01 Rs99.59
17 UNH UnitedHe: Rs362.50 Rs2.05 56.87% Rs234.60  Rs263.46
18 NVO Novo Nore Rs52.96 Rs0.27 50.72% Rs44.55 Rs487.45
19 MA Masterca Rs573.67 Rs0.10 1.74% Rs464.22  Rs470.17
20 PG Procter & Rs152.49 Rs1.33 87.83% Rs149.91 Rs128.86
21 INJ Johnson8 Rs190.40 Rs2.07 107.55% Rs137.37  Rs190.43)
2
23
24
25
2
27
28
29
30
31
Sheet1 ® R

Value Trades VX

VALUE TRADES

Value Trades Excel Tool

ready E® T2 Accessivility: Good to go

»

EDwerre starting the add-ins runtime, just a moment...

Sample data inserted and formatted successfully!

Enter your API Key

Value Trades Functions

Enter Cell Value of Symbol

Name Y

Insert Formula

© 2025 value-trades.com. All rights reserved

H @ O -—F—+ %

22|Page



